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Operating Instruct

duction

aximum versatility from this machine all operators should carefully read and follow t
 in this manual. Please keep this manual in a handy place near the printer.

ad the Safety Information before using this printer. It contains important information r
 SAFETY and PREVENTING EQUIPMENT PROBLEMS.

t

his manual are subject to change without prior notice. In no event will the company be
, indirect, special, incidental, or consequential damages as a result of handling or operati

rks

t®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation 
ates and/or other countries.
nd PostScript® are registered trademarks of Adobe Systems Incorporated.
, Apple, Macintosh is a registered trademark of Apple Computer, Incorporated.
duct names used herein are for identification purposes only and might be trademarks o
e companies. We disclaim any and all rights in those marks.

strations might be slightly different from your machine.
ptions might not be available in some countries. For details, please contact your local d
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stScript 3

lling the PostScript Printer Driver

ion describes basic instructions for installing the printer driver. The actual procedure ma
ding on the operating system. Follow one of the appropriate procedures below.

rtant
 updating the printer driver by installing the latest version, you should uninstall any forme

rst. See the Printer Client Reference 2.

ws 95/98/Me - Installing the PostScript Printer Driver

 the printer driver

rtant
re to install the PPD file for Windows 95/98/Me. Do not accidentally install the PPD file fo
2000 or Windows NT 4.0.

 all applications that are currently running.

 [Start] on the taskbar, point to [Settings], and then click [Printers].
rinters] window appears.

le-click the [Add Printers] icon.

rinter Wizard] starts.

 [Next].
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Operating Instruct

k [Local Printer], and then click [Next].
alog box for selecting the printer manufacturer and model name appears.

k [Have Disk].
alog box for installing the printer driver from a disk appears.

 down the {{{{SHIFT}}}} key and insert the CD-ROM into the CD-ROM drive. Kee
FT}}}} key held down until the computer has finished accessing the CD-ROM.

 Auto Run program starts, click [Cancel].

k [Browse].

ct the CD-ROM in the [Drives:] list box.

e [Folders:] box, double-click [DRIVERS], [PS], [WIN9X_ME]. Then double-click the f
e appropriate language for the operating system. Finally, click [DISK1].

k [Open].

k [OK].

k to select the name of the printer whose driver you want to install, and then click [

e [Available ports:] box, click to select [Printer Port], and then click [Next].

nge the name of the printer if you want, and then click [Next].

ct whether or not you want to print a test page, and then click [Finish].

u are asked whether you want to restart Windows, select [Yes]. If you are not aske
 Windows after completing the installation.
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 up options

ortant
 printer is equipped with certain options (e.g. the Paper Feed Unit or the Memory Unit
ld set up the options with the printer driver.

k [Start] on the taskbar, point to [Settings], and then click [Printers].
[Printers] window appears.

k to select the icon of the printer you want to use.

he [File] menu, click [Properties].
[Printer Properties] dialog box appears.

k the [Accessories] tab.

e [Options] group, select the option you have installed on the printer.

the [Change settings for:] list box to select the appropriate setting for the selected op

k [Apply] to apply the settings you made.

eat steps EEEE – GGGG for all options.

r making all settings for options, click [OK].
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ws 2000 - Installing the PostScript Printer Driver

g the printer driver

itation
lling a printer driver requires Manage Printers permission. Members of the Administrators, an
er Users groups have Manage Printers permission by default. When you install a printer drive
n using an account that has Manage Printers permission.

ortant
ure to install the PPD file for Windows 2000. Do not accidentally install the PPD file for Window
8/Me or Windows NT 4.0.

e all applications that are currently running.

k [Start] on the taskbar, point to [Settings], and then click [Printers].
[Printers] window appears.

ble-click the [Add Printers] icon.

 Printer Wizard] starts.

r confirming that the [Local Printer] option is selected, click [Next].
alog box for selecting the printer port appears.

ct the check box of the port you want to use, and then click [Next].
alog box for selecting the printer manufacturer and model name appears.

k [Have Disk].
alog box for installing the driver from a disk appears.
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 down the left {{{{SHIFT}}}} key and insert the CD-ROM into the CD-ROM drive. Kee
SHIFT}}}} key held down until the computer has finished accessing the CD-ROM.

 Auto Run program starts, click [Cancel].

nge the drive name in the list box to the name of the CD-ROM drive, and then 
wse].

e [Folders:] box, double-click [DRIVERS], [PS], [WIN2000]. Then double-click the fold
ppropriate language for the operating system. Finally, click [DISK1].

k [Open].

k [OK].
inter model selection dialog box appears.

k to select the name of the printer whose driver you want to install, and then click [N
alog box for changing the printer name appears.

nge the name of the printer if you want, and then click [Next].

k [Next].

e next dialog box you will be asked to print a test page, select [No], and then click [N
nfirmation dialog box appears.

firm the settings you have set, and then click [Finish].
installer copies the printer driver files from the CD-ROM to the computer's hard disk.

p the options with the printer driver.
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art Windows.

ote
rint a test page after completing installation.

 up options

itation
ging the setting of the printer requires Manage Printers permission. Members of the Ad

rs and Power Users groups have Manage Printers permission by default. When you set u
, log on using an account that has Manage Printers permission.

ortant
 printer is equipped with certain options (e.g. the Paper Feed Unit or the Memory Unit
ld set up the options with the printer driver.

k [Start] on the taskbar, point to [Settings], and then click [Printers].
[Printers] window appears.

k the icon of the printer you want to use. On the [File] menu, click [Properties].

k the [Device Settings] tab.

k the installed option in the [Installable Options] box, and then select [Installed] or [N
d] from the drop-down list box.

eat step DDDD for all options.

r making all settings you want, click [OK].
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ws NT 4.0 - Installing the PostScript Printer Driver

g the printer driver

itation
lling a printer driver requires Full Control access permission. Members of the Administra
er Operators, Print Operators, and Power Users groups have Full Control permission by
. When you install a printer driver, log on using an account that has Full Control permissio

ortant
CD-ROM containing the Windows NT Server operating system version 4.0, or the Windows
station operating system is required for installing the printer driver.

ecommend that you upgrade the Windows NT 4.0 operating system to Service Pack 4 or 
re installing the printer driver. Contact your Windows retailer for more information about the
ersion available.

ure to install the PPD file for Windows NT 4.0. Do not accidentally install the PPD file for W
 95/98/Me or Windows 2000.

e all applications that are currently running.

k [Start] on the taskbar, point to [Settings], and then click [Printers].
[Printers] window appears.

ble-click the [Add Printers] icon.

 Printer Wizard] starts.

r confirming that the [My Computer] option is selected, click [Next].
alog box for selecting the printer port appears.
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ct the check box of the port you want to use, and then click [Next].
alog box for selecting the printer manufacturer and model name appears.

k [Have Disk].
alog box for installing the driver from a disk appears.

 down the {{{{SHIFT}}}} key and insert the CD-ROM into the CD-ROM drive. Keep th
FT}}}} key held down until the computer has finished accessing the CD-ROM.

 Auto Run program starts, click [Cancel].

nge the drive name in the list box to the name of the CD-ROM drive, and then click
wse].

e [Folders:] box, double-click [DRIVERS], [PS], [NT4]. Then double-click the folder of th
opriate language for the operating system. Finally, click [DISK1].

k [Open].

k [OK].
inter model selection dialog box appears.

k to select the name of the printer whose driver you want to install, and then click [Next]
alog box for changing the printer name appears.

nge the name of the printer if you want, and then click [Next].

k [Next].

e next dialog box asking if you want to print a test page, select [No] and then click [Finish]
installer copies the printer driver files from the CD-ROM to the computer's hard disk.



ions
12

N
❒ P

PPPP If yo d, re-
start

Setting

Lim
❒ Chan dmin-

istra ission
by d .

Imp
❒ If the ), you

shou

AAAA Clic

The 

BBBB Clic

CCCC On t

The 

DDDD Clic

EEEE In th

The 
Operating Instruct

ote
rint a test page after completing installation and restarting Windows.

u are asked whether you want to restart Windows, select [Yes]. If you are not aske
 Windows after completing the installation.

 up options

itation
ging the setting of the printer requires Full Control access permission. Members of the A

tors, Server Operators, Print Operators, and Power Users groups have Full Control perm
efault. When you setup options, log on using an account that has Full Control permission

ortant
 printer is equipped with certain options (e.g. the Paper Feed Unit or the Memory Unit
ld set up the options with the printer driver.

k [Start] on the taskbar, point to [Settings], and then click [Printers].
[Printers] window appears.

k to select the icon of the printer you want to use.

he [File] menu, click [Properties].
[Printer Properties] dialog box appears.

k the [Device Settings] tab.

e [Installable Options] group, select the option you have installed on the printer.

current setting appears in the [Change Setting] box.
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Operating Instructio

the [Change Setting:] list to select the appropriate setting for the selected option.

eat steps EEEE – FFFF for all options.

r making all option settings, click [OK].

g Adobe PageMaker Version 6.0 or 6.5

se the printer under Windows 95/98/Me, Windows 2000, Windows NT 4.0 with Adobe P
you need to copy the PPD file to the PageMaker folder. 

 file is the file with extension ".ppd" on the CD-ROM. It is in the folder as follows: 

dows 95/98/Me
VERS\PS\WIN9X_ME\(Language)\DISK1\

dows 2000
VERS\PS\WIN2000\(Language)\DISK1\

dows NT 4.0
VERS\PS\WIN\NT4\(Language)\DISK1\

N95_98] folder, inside the [PS] folder is for the Windows 95/98/Me operating system. Use
t this level that is appropriate for the operating system you are using.

d folder, "(Language)" may be substituted by an appropriate language name. 

is file to the PageMaker folder.

eMaker 6.0 default installation, the folder is "C:\PM6\RSRC\PPD4", and for PageMaker
installation, the directory is "C:\PM65\RSRC\USENGLISH\PPD4". The "USENGLISH" 
pending on your language selection.
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Operating Instruction

tosh

sh - Installing the PostScript Printer Driver

essary to install a printer driver and a PPD file to print from a Macintosh.

these steps to install a printer driver and a PPD file into a Macintosh using MacOS 7.6.1 or late

rt the CD-ROM into the CD-ROM drive.

ble-click the CD-ROM icon.

ble-click the [PS] folder.

ble-click the folder of the language you use.

n [DISK1], and then double-click the installer icon.

w the instructions on the screen.

ble-click [Extensions].

ble-click [Printer Descriptions].

ble-click the CD-ROM icon on the desktop.

ble-click [DISK1] in the folder of the language you use.

 the PPD file into [Printer Descriptions].

 the Plugin file into [Printer Descriptions] in [Extensions] in [System Folder].

art the Macintosh.
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Operating Instruction

 Up the PPD File

aration
irm that the printer is connected to an AppleTalk network before performing the following pr
re.

he [Apple] menu, select [Chooser].

k the [Adobe PS] icon.

e [Select a PostScript Printer:] list, click the name of the printer you want to use.

k [Create].

k the printer you want to use, and then click [Select].
PPD file is set up, and the [Adobe PS] icon appears at the left of the printer name in the li
, follow the procedure on p.15 “Setting Up Options” to make the option settings, or close t
oser] dialog box.

 Up Options

he [Apple] menu, select [Chooser].

k the [Adobe PS] icon.

e [Select the PostScript Printer:] list, click the name of the printer you want to use, and the
 [Setup].

k [Configure].
t of options appears.
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ct the option you want to set up, and then select the appropriate setting for it.

ote
 the option you want to set up is not displayed, the PPD file might not be set up correctly. C
e name of the PPD file shown in the dialog box.

k [OK].
list of options closes.

k [OK].
[Chooser] dialog box appears.

e the [Chooser] dialog box.

g the ColorSync profile

nc profile make it possible for the printer to print colors of similar intensity to those that a
 computer display. You must install the ColorSync profile to use this feature.

ColorSync profile conform with the color characteristics defined by the International Colo
um (ICC).

e computer displays may require particular settings to be controlled by ColorSync. See th
ntation that comes with your display for details.

owing procedure shows how to install the ColorSync Profile.
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Operating Instruct

t the Macintosh.

ble-click the hard disk icon, and then open the appropriate folder for installing the C
 profile.

ote
he location of the appropriate folder may differ depending on the version of the operatin
m. The following are examples:

System:Preferences:ColorSync Profiles

System:ColorSync Profiles

rt the CD-ROM into the CD-ROM drive.

icon of the CD-ROM appears.

ble-click the CD-ROM icon.

contents of the CD-ROM appear.

ble-click the [ColorSyncTM Profiles] folder in the CD-ROM.

 the file to the [ColorSyncTM Profiles] folder on the hard disk.

ColorSync profile is installed.
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stalling the PostScript Printer Driver

tion describes how to uninstall the PostScript printer driver.

al procedure may differ depending on the operating system.

the appropriate procedure below.

ws 95/98/Me - Uninstalling the PostScript Printer Driver

e all applications that are currently running. 

k [Start] on the taskbar, point to [Settings], and then click [Printers].
[Printers] window appears.

k to select the icon of the printer you want to remove. 

he [File] menu, click [Delete].
nfirmation dialog box appears.

k [Yes] to uninstall the printer driver.
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ws 2000 - Uninstalling the PostScript Printer Driver

itation
stalling a printer driver requires Manage Printers permission. Members of the Administ
Power Users groups have Manage Printers permission by default. When you uninstall a p
r, log on using an account that has Manage Printers permission.

e all the applications that are currently running.

k [Start] on the taskbar, point to [Settings], and click [Printers].
[Printers] window appears.

k to select the icon of the printer you want to remove.

he [File] menu, click [Delete].
nfirmation dialog box appears. 

k [Yes] to uninstall the printer driver.
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ws NT 4.0 - Uninstalling the PostScript Printer Driver

itation
stalling a printer driver requires Full Control access permission. Members of the Administr
er Operators, Print Operators, and Power Users groups have Full Control Permission b
. When you uninstall a printer driver, log on using an account that has Full Control permi

e all applications that are currently running. 

k [Start] on the taskbar, point to [Settings], and then click [Printers].
[Printers] window appears.

k to select the icon of the printer you want to remove. 

he [File] menu, click [Delete].
nfirmation dialog box appears.

k [Yes] to uninstall the printer driver.
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llable Options

owing options are available.

r Feed Unit
00 sheets x 1 Tray

00 sheets x 2 Tray

000 sheets LCT

ut Paper Device
uplex Unit

ailbox

inisher

inisher with Punch

inisher with Staple

ory Unit
rinter Hard Disk

DRAM
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ting a Document

tion describes how to print a document using printer specific functions.

r Mode
following table shows the tabs or menus where you can select this function.

portant
hen you use Windows 95/98/Me, you can configure this function from “Color/Black and W

ote
se this to set the output color to [Black and White] or [Color].

r Setting
following table shows the tabs or menus where you can set the correction method used for
ersion.

portant
hen you use Windows 95/98/Me, you can configure [Color Setting] in [Advanced] by sel
anual] from the [Color] setting. [Automatic] sets the printer to "Super Fine".

dows 95/98/Me [Setup] tab

dows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab 
Printing Preferences Properties

dows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] 

intosh [Printer Specific Options] in the print dialog box
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ote
he color rendering dictionary that is selected in the “Color Profile” setting is used.

se this setting to set the correction method used for color conversion. The following item
vailable: [Off] *1  , [Fine] *2  , [Super Fine] *3  . 
o modification to the color setting.
elect this setting to perform color matching based on one of the printer's built-in color renderin
onaries and perform CMYK conversion. This setting perform the printing which output ta
oritor γ = 1.8.

elect this setting to use a color rendering dictionary as in the "Fine" setting but produce outp
 more vivid. Use this setting to emphasis light colors. This setting perform the printing which 
rget is Moritor γ = 2.2.

dows 95/98/Me [Advanced] on the [Print Quality] tab

dows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab 
Printing Preferences Properties

dows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] 

intosh [Printer Specific Options] in the print dialog box
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r Profile
following table shows the tabs or menus where you can select this function.

portant
hen you use Windows 95/98/Me, you can configure [Color Profile] in [Advanced] by selec
anual] from the [Color] setting. [Automatic] sets the printer to "Presentation".

ote
se this to select a color rendering dictionary (CRD). The CRD is referred to for color match
o you should select the appropriate CRD for the document you are printing. The CRD you se
 also referred to when [Fine] or [Super Fine] is selected for “Color Setting”. The following ite
re available: [Photograph] *1 , [Presentation] *2  and [Solid Color] *3 .
se this setting to enhance the reproduction of photos and graphics that include midtones.
se this setting to enhance the reproduction of documents that contain text and graphics. This C
 best for printing colored charts, graphs, presentation materials and so on. If you use this CRD
rinting photographs, the color or gradations might not be reproduced well.
se this setting to print specific colors, logos and so on.

dows 95/98/Me [Advanced] on the [Print Quality] tab

dows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in t
Printing Preferences Properties

dows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tab

intosh [Printer Specific Options] in the print dialog box
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ation
this to set the printing mode to [Standard] or [Fast].

imitation
hen the resolution option is set to [1200dpi], the gradation option must be set to [Fast].

lution
this to set the resolution to [600dpi] or [1200dpi].

imitation
hen the resolution option is set to [600dpi] and gradation option is set to [Fast], the outpu

e printet with 600 × 600dpi.

hen the resolution option is set to [600dpi] and gradation option is set to [Standard], the o
ill be printet with 1200 × 600dpi.

dows 95/98/Me [Advanced] on the [Print Quality] tab

dows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab 
Printing Preferences Properties

dows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] 

intosh [Printer Specific Options] in the print dialog box

dows 95/98/Me [Advanced] on the [Print Quality] tab

dows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab 
Printing Preferences Properties

dows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] 

intosh [Printer Specific Options] in the print dialog box
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ering
this to set the image rendering mode.

portant
hen you use Windows 95/98/Me, you can configure [Dithering] in [Advanced] by selecting

al] from the [Color] setting. [Automatic] sets the printer to "Photographic".

dows 95/98/Me [Advanced] on the [Print Quality] tab

dows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab 
Printing Preferences Properties

dows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] 

intosh [Printer Specific Options] in the print dialog box
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Operating Instruct

 Reproduction (Black Text/Graphics)
this to select the black color mode for text and line art.

portant
hen you use Windows 95/98/Me, you can configure [Gray Reproduction] in [Advanced] by s
g [Manual] from the [Color] setting. [Automatic] sets the printer to "Pure Black Text".

ote
se this to select [K] *1  *2  or [CMY+K] *3 .
elect this setting to use a black toner.
hen you use Windows 95/98/Me,  this mode is called “Pure Black Text”.

elect this setting to use all toners.

dows 95/98/Me [Advanced] on the [Print Quality] tab

dows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab 
Printing Preferences Properties

dows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] 

intosh [Printer Specific Options] in the print dialog box
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k Over Print
ct whether or not to apply a black color over any other colors when printing.
 is useful when a white opening in background is noticeable in black text and graphics.

portant
hen you use Windows 95/98/Me, you can configure [Black Over Print] in [Advanced] by sel
anual] from the [Color] setting.

r Source
following table shows the tabs or menus where you can select this function.

dows 95/98/Me [Advanced] on the [Print Quality] tab

dows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab 
Printing Preferences Properties

dows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] 

intosh [Printer Specific Options] in the print dialog box

dows 95/98/Me [All Pages] on the [Paper] tab

dows 2000 [Paper/Quality] tab in the Printing Preferences Properties

dows NT 4.0 [Page Setup] tab

intosh [General] in the print dialog box
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ination Tray
following table shows the tabs or menus where you can select this function.

lex Printing
this function to select duplex printing.

imitation
o use this function, the Duplex Unit must be installed on the printer.
following table shows the tabs or menus where you can select this function.

dows 95/98/Me [Destination] on the [Paper] tab

dows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab 
Printing Preferences Properties

dows NT 4.0 [Printer features] on [Document Options] on the [Advanced] t

intosh [Printer Specific Options] in the print dialog box

dows 95/98/Me [Duplex] on the [Setup] tab

dows 2000 [Print on Both Sides (Duplex)] on the [Layout] tab in the Print
Preferences Properties

dows NT 4.0 [Page Setup] tab

intosh [Print on Both Sides] on [Layout] in the print dialog box
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te
this function to enable collation. With this feature, the printer can efficiently print collate
ultiple-page documents.

imitation
o use this function, a Memory Unit of at least 128MB or Hard Disk Drive must be instal
e printer.
following table shows the tabs or menus where you can select this function.

dows 95/98/Me [Collate] on the [Setup] tab

dows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab i
Printing Preferences Properties

dows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] t

intosh [Printer Specific Options] in the print dialog box
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le
this function to have the output stapled. When you turn Staple on, the printed document 
 automatically. You should switch off Collate from the Print window of your application t
 the entire job from being stapled together. 

imitation
o use this function, the finisher must be installed on the printer.

eference
or more information, see the Printer Client Reference 2.
following table shows the tabs or menus where you can select this function.

ou must select "Finisher Shift Tray 1" or "Finisher Shift Tray 2" for the destination tray sett

dows 95/98/Me [Staple] on the [Setup] tab

dows 2000 *1 [Printer Features] on [Advanced...] on the [Paper/Quality] tab 
Printing Preferences Properties

dows NT 4.0 *1 [Printer features] on [Document Options] on the [Advanced] t

intosh *1 [Printer Specific Options] in the print dialog box
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h
this function to have the output punched.

imitation
o use this function, the finisher with punch must be installed on the printer.

eference
or more information, see the Printer Client Reference 2.
following table shows the tabs or menus where you can select this function.

ou must select "Finisher Shift Tray 1" or "Finisher Shift Tray 2" for the destination tray setting.

r Saver
this function to reduce the amount of toner used when printing.

ote
his will have low toner consumption, so that the output will appear slightly ligter.
following table shows the tabs or menus where you can select this function.

dows 95/98/Me [Punch] on the [Setup] tab

dows 2000 *1 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 
Printing Preferences Properties

dows NT 4.0 *1 [Printer features] on [Document Options] on the [Advanced] tab

intosh *1 [Printer Specific Options] in the print dialog box

dows 95/98/Me [Toner Saver] on the [Print Quality] tab

dows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the 
Printing Preferences Properties

dows NT 4.0 [Printer features] on [Document Options] on the [Advanced] tab

intosh [Printer Specific Options] in the print dialog box
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ple Print
this function to print only one set of a multiple print job.
other sets are saved in the machine. The saved job can be printed from the machine's operat
l. You can also delete the saved job.

imitation
o use this function, the Hard Disk Drive must be installed on the printer.

ote
he “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0–9) characters.

ntering the “User ID” helps you to distinguish the print job from others.
following table shows the tabs or menus where you can select this function.

dows 95/98/Me [Job Type] on the [Setup] tab

dows 2000 [Job Type] on the [Job/Log] tab

dows NT 4.0 [Job Type] on the [Job/Log] tab

intosh [Job Log] in the print dialog box
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ed Print
this function to save documents in the machine memory with a password, and then edit and
 as you want.

imitation
o use this function, the Hard Disk Drive must be installed on the printer.

ote
he “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0–9) characters. The “Pass
ust be four digits.
following table shows the tabs or menus where you can select this function.

dows 95/98/Me [Job Type] on the [Setup] tab

dows 2000 [Job Type] on the [Job/Log] tab

dows NT 4.0 [Job Type] on the [Job/Log] tab

intosh [Job Log] in the print dialog box
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le Print

the procedures below to print a document using the “Sample Print” function.

owing procedure uses the sample User ID: ABCD1234.

s 95/98/Me

 application has a collate option, make sure that it is not selected before sending a print job. B
ult, sample print jobs are automatically collated by the printer driver. If the collate option is se
d in the application print dialog box, more prints than intended may be printed.

 an application, select the menu command to print.

print dialog box appears.

n the Printer Properties.

k to select the [Setup] tab.

ct [Sample Print] in the [Job Type].

k the [Details...]

r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9
acters. 

ote
his is used to identify the user associated with a job.

he "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.
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Operating Instructions

k [OK].

k [OK] to close the Printer Properties.

t printing from the application's print dialog box.

Sample Print job is sent to the machine and one set is printed.

ck the sample print to confirm that the settings are all right.

 settings are fine, go to step K to print the remaining sets.

t, you can delete the saved job. ⇒  p.42 “Deleting a Sample Print file” 

he machine's operation panel, press {{{{Menu}}}}.

s {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

s {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

Menu:

 Sample Print

Sample Print:

08:56 ABCD1234
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Operating Instruction

s {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press {{{{Enter qqqq}}}} to prin
ile.

following message appears on the panel display.

Qty:  1(1-999)

Press #To Print

Processing...
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s 2000, Windows NT 4.0

 application has a collate option, make sure that it is not selected before sending a print job. B
ult, sample print jobs are automatically collated by the printer driver. If the collate option is se
d in the application print dialog box, more prints than intended may be printed.

 an application, select the menu command to print.

print dialog box appears.

n the Printer Properties.

k to select the [Job/Log] tab.

ct [Sample Print] in the [Print Job].

r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9
acters. 

ote
his is used to identify the user associated with a job.

he "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

k [OK] to close the Printer Properties.

t printing from the application's print dialog box.

Sample Print job is sent to the machine and one set is printed.

ck the sample print to confirm that the settings are all right.

 settings are fine, go to step I to print the remaining sets.

t, you can delete the saved job. ⇒  p.42 “Deleting a Sample Print file” 
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Operating Instruction

he machine's operation panel, press {{{{Menu}}}}.

s {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

s {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press {{{{Enter qqqq}}}} to prin
ile.

following message appears on the panel display.

Menu:

 Sample Print

Sample Print:

08:56 ABCD1234

Qty:  1(1-999)

Press #To Print

Processing...
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 an application, select the menu command to print.

print dialog box appears.

k to select the [Job Log].

ct [Sample Print], and then select the appropriate setting.

r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z
acters. 

ote
his is used to identify the user associated with a job.

he "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

r making all of the settings you want, click [Print].
Sample Print job is sent to the machine and one set is printed.

ck the sample print to confirm that the settings are all right.

 settings are fine, go to step G to print the remaining sets.

t, you can delete the saved job. ⇒  p.42 “Deleting a Sample Print file” 

he machine's operation panel, press {{{{Menu}}}}.
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Operating Instruct

s {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

s {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press {{{{Enter qqqq}}}} to
ile.

following message appears on the panel display.

Menu:

 Sample Print

Sample Print:

08:56 ABCD1234

Qty:  1(1-999)

Press #To Print

Printing...
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Operating Instruct

 a Sample Print file

inted document is not what you expected, you can delete the sample print file.

s {{{{Menu}}}}.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display "Sample Print", and then press {{{{Enter qqqq}}}}.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to delete, and then press {{{{Enter qqqq}}}}.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display “Delete File”, and then press {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{Enter qqqq}}}} to delete the file.

following message appears on the panel display.

08:56 ABCD1234

Press # To Del.

Deleted
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d Print

the procedures below to print a document using the “Locked Print” function.

owing procedure uses the sample User ID: ABCD1234.

s 95/98/Me

 an application, select the menu command to print.

print dialog box appears.

n the Printer Properties.

k to select the [Setup] tab.

ct [Locked Print] in [Job Type].

k the [Details...]

r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z
acters. Then enter a password in [Password], up to four digits. 

ote
his is used to identify the user associated with a job.

he "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters. The “Pass
ust be four digits.

k [OK].

k [OK] to apply the settings you made.
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Operating Instruct

r making all of the settings you want, click [OK] to close the Printer Properties.

document file is saved in the printer.

u want to print this document, go to step J to print the remaining sets.

t, you can delete the saved job. ⇒  p.52 “Deleting a Locked Print file” 

he machine's operation panel, press {{{{Menu}}}}.

s {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

s {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to set the digit in the password entry field.

Menu:

 Locked Print

Locked Print:

08:56  ABCD1234

Password:

[0---]



ions
45

OOOO Pres

The 

PPPP Rep

Chec  pass-
word

QQQQ Pres

The 

RRRR Pres  print
the f

The 

  

  

  

 

Operating Instruct

s {{{{Enter qqqq}}}}.

pointer ( k ) moves to the next entry field automatically.

eat steps NNNN and OOOO to set the password.

k if the pointer ( k ) is at the rightmost position, and then press {{{{Enter qqqq}}}} to register the
 you selected.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press {{{{Enter qqqq}}}} to
ile.

following message appears on the panel display.

Qty:  1(1-999)

Press # To Print 

Printing...
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s 2000, Windows NT 4.0

 an application, select the menu command to print.

print dialog box appears.

n the Printer Properties.

k to select the [Job/Log] tab.

ct [Locked Print] in [Print Job].

r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z
acters. Then enter a password in [Password], up to four digits. 

ote
his is used to identify the user associated with a job.

he "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters. The “Pass
ust be four digits.

k [OK] to apply the settings you made.

r making all of the settings you want, click [OK] to close the Printer Properties.

document file is saved in the printer.

u want to print this document, go to step H to print the remaining sets.

t, you can delete the saved job. ⇒  p.52 “Deleting a Locked Print file” 

he machine's operation panel, press {{{{Menu}}}}.
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Operating Instruct

s {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

s {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to set the digit in the password entry field.

s {{{{Enter qqqq}}}}.

pointer ( k ) moves to the next entry field automatically.

eat steps LLLL and MMMM to set the password.

k if the pointer ( k ) is at the rightmost position, and then press {{{{Enter qqqq}}}} to register the
 you selected.

Menu:

 Locked Print

Locked Print:

08:56  ABCD1234

Password:

[0---]
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Operating Instruct

s {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press {{{{Enter qqqq}}}} to
ile.

following message appears on the panel display.

Qty:  1(1-999)

Press # To Print 

Printing...
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 an application, select the menu command to print.

print dialog box appears.

k to select the [Job Log].

ct [Locked Print],and then select the appropriate setting.

r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9
acters. Then enter a password in [Password], up to four digits. 

ote
his is used to identify the user associated with a job.

he "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters. The “Password
ust be four digits.

r making all of the settings you want, click [Print].
Sample Print job is sent to the machine and one set is printed.

ck the locked print to confirm that the settings are all right.

 settings are fine, go to step G to print the remaining sets.

t, you can delete the saved job. ⇒  p.52 “Deleting a Locked Print file” 

he machine's operation panel, press {{{{Menu}}}}.

s {{{{UUUU}}}} or {{{{TTTT}}}} until the following message appears on the panel display.

Menu:

 Locked Print
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Operating Instructions

s {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to print, and then press {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to set the digit in the password entry field.

s {{{{Enter qqqq}}}}.

pointer ( k ) moves to the next entry field automatically.

eat steps KKKK and LLLL to set the password.

k if the pointer ( k ) is at the rightmost position, and then press {{{{Enter qqqq}}}} to register the pass
 you selected.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display "Print File", and then press {{{{Enter qqqq}}}}.

following message appears on the panel display.

Locked Print:

08:56  ABCD1234

Password:

[0---]

Qty:  1(1-999)

Press # To Print 
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s {{{{UUUU}}}} or {{{{TTTT}}}} to change the document quantity desired, and then press {{{{Enter qqqq}}}} to
ile.

following message appears on the panel display.

Printing...
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Operating Instruction

 a Locked Print file

inted document is not what you expected, you can delete the Locked print file.

s {{{{Menu}}}}.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display "Locked Print", and then press {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display the file you want to delete, and then press {{{{Enter qqqq}}}}.

following message appears on the panel display.

s {{{{UUUU}}}} or {{{{TTTT}}}} to set the digit in the password entry field.

s {{{{Enter qqqq}}}}.

pointer ( k ) moves to the next entry field automatically.

eat steps DDDD and EEEE to set the password.

k if the pointer ( k ) is at the rightmost position, and then press {{{{Enter qqqq}}}} to register the pas
 you selected.

s {{{{UUUU}}}} or {{{{TTTT}}}} to display "Delete File", and then press {{{{Enter qqqq}}}}.

following message appears on the panel display.

Password:

[0---]

08:56 ABCD1234

Press # To Del.
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s {{{{Enter qqqq}}}} to delete the file.

following message appears on the panel display.

Deleted
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ter Utility for Mac

g Printer Utility for Mac, you can download fonts, change the name of printer and so on

er Utility for Mac is included on the CD-ROM labeled “Drivers and Utilities”.

er Utility for Mac requires Mac OS 7.6.1 or later.

ling Printer Utility for Mac

these steps to install Printer Utility for Mac on the machine.

t the Macintosh.

rt the CD-ROM into the CD-ROM drive.

icon of the CD-ROM appears.

ble-click the icon of hard disk to open it.

ble-click the CD-ROM icon.

contents of the CD-ROM appear.

ble-click the [PS Utility] folder of the CD-ROM, and then drag the [Printer Utility fo
nd drop it into the Macintosh hard disk.

 the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.

er Utility for Mac is installed.
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ng Printer Utility for Mac

owing instructions describe how to start Printer Utility for Mac.

ortant
re starting Printer Utility for Mac, confirm that the printer is selected with [Chooser] on the Apple
u.

ble-click the icon of Printer Utility for Mac.

Printer Utility for Mac dialog box appears.

k [OK].
er Utility for Mac will take a few seconds to start.

eference
or more information, see “Printer Utility for Mac Functions”. 

r Utility for Mac Functions

tility for Mac functions are described below.

menu
ownload PS Fonts...]
ownload fonts (PostScript Type 1) to the printer. See p.57 “Downloading PS Fonts”.

isplay Printer's Fonts...]
isplay and delete the fonts in printer memory and the printer's hard disk drive. See p.58 “Dis-
laying Printer's Fonts”.

nitialize Printer's Disk...]
itialize the printer's hard disk drive. See p.60 “Initializing the Printer Disk”.
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age Setup...]
et up the paper size to print “Printer Font Catalog” and “Printer Font Sample”. See p.61 “Pa
etup”.

rint Font Catalog...]
rint the names of available fonts. See p.61 “Printing Font Catalog”.

rint Font Sample...]
rint a sample of fonts. See p.61 “Printing Font Sample”.

ename Printer...]
hange the printer's name when viewed via Appletalk. See p.62 “Renaming the Printer”.

estart Printer]
estart the printer. See p.63 “Restarting the Printer”.

y menu
ownload PostScript File...]
ownload a PostScript File. See p.63 “Downloading PostScript Files”.

elect Zone...]
hange the zone the printer belongs to via Appletalk. See p.64 “Selecting the Zone”.

isplay Printer Status...]
isplay the status of the printer. See p.65 “Displaying the Printer Status”.

aunch Dialogue Console...]
reate and edit a PostScript file, and download it to the printer. See p.65 “Launching the D
gue Console”.
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loading PS Fonts

 download the PS fonts to the printer's memory or hard disk drive.

ortant
following procedures to download the fonts assumes that you are a system administrator. If yo
ot, be sure to consult your system administrator.

 printer restarts, all the printer settings return to their defaults.

irm that Macintosh and the printer are connected with Appletalk.

e fonts cannot be downloaded.

re downloading, read the documentation of the fonts you want to use.

ct [Download PS Fonts...] on the [File] menu.

k [Add to list].
dialog box to select fonts appears.

k to select the desired font files, and then click [Open].
list of selectable font names appears.

r adding all the fonts you want to download, click [OK].
dialog box of selected fonts to download appears.
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k [Download].
fonts begin to download, and the download status is shown.

portant
uring the download, do not turn off the power switch, operate the panel or open or clo
over.

n the completion message appears, click [OK].

k [Cancel].

ying Printer's Fonts

 display the available fonts currently downloaded to the printer. Fonts in the printer's me
 disk drive can be displayed.

fonts displayed in italics are the default fonts.

ct [Display Printer's Fonts...] on the [File] menu.

alog box appears.

ct [Printer's memory] or [Printer's disk].

k [OK].
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ng Fonts

 delete fonts from the printer's memory or hard disk drive.

ct [Display Printer's fonts] on the [File] menu.

alog box appears.

ct the [Printer's memory] or [Printer's disk].

ct the fonts you want to delete.

imitation
ou cannot delete the fonts displayed in italic.

k [Delete].
nfirmation message appears.

firm the fonts you want to delete and the printer name from which you want to dele
s.

k [Continue], and then click [OK].

k [OK].
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izing the Printer Disk

itializing the printer's hard disk, all the fonts downloaded to the printer's hard disk driv
 Before initializing, be sure to check the fonts on the hard disk drive.

ortant
n initializing the printer's hard disk drive from the operation panel, all of the data on the pr
 disk drive is deleted. Before initializing, be sure to check the data on the hard disk drive

ct [Initialize Printer's Disk...] on the [File] menu.

confirmation message appears.

ote
o cancel initialization, click [Cancel].

k [Execute].
lizing starts.

portant
o not turn off the power switch until initializing is completed, otherwise the hard disk drive
e damaged.

n the completion message appears, click [OK].



ions
61

Page 

You can .

AAAA Sele

BBBB Cho

Printi

Print the

Note
❒ The 

AAAA Sele

BBBB Clic

Printi

You can

Note
❒ Print

AAAA Sele

BBBB Clic
Operating Instruct

Setup

 set the paper size on which to print “Print Fonts Catalogue” and “Prints Fonts Sample”

ct [Page Setup...] on the [File] menu.

ose the paper size.

ng Font Catalog

 names of fonts available on the printer.

paper selected under [Page Setup] is used.

ct [Print Fonts Catalogue] on the [File] menu.

k [Print].

ng Font Sample

 print samples of fonts downloaded to the hard disk drive or memory.

 by using the paper selected on [Page Setup].

ct [Print Fonts Sample...] on the [File] menu.

k [Print].
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 change the printer's name displayed under Appletalk. If you connect several printer
, assign different names so you can identify them. If several printers have the same nam
 next to the printer name in the [Chooser].

ct [Rename Printer...] on the [File] menu.

e a new name in the [New Name:] field. 

imitation
ou can enter up to 31 digits and letters.

o not use symbols, for example “*”, “:”, “=”,”@”, “~”.

k [Rename].
printer name is changed.

s [OK].

ct [Chooser] on the Apple menu.

k the icon of [AdobePS].

k to select the printer name renamed in step BBBB and then close [Chooser].

ote
 there are several Appletalk zone, select the zone the printer belongs to.
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rting the Printer

 restart the printer.

ct [Restart Printer] on the [File] menu.

firm the message that appears on the screen, and then click [Restart].
printer restarts.

ote
he fonts that you downloaded in the printer's memory will be deleted.

 the printer restarts, all the printer settings return to their defaults.

loading PostScript Files

 download a Postscript file to the printer.

ct [Download PostScript File...] on the [Utility] menu.

ct the file name to download and click the file name, and then click [Open].

e the log file name, and then click [Save].
selected file is downloaded.

ote
rrors are recorded in the log file.
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ting the Zone

 change the zone to which the printer belongs under Appletalk.

ortant
irm that the printer and a Macintosh are connected in an Appletalk environment.

ct [Select Zone...] on the [Utility] menu.

zone to which the printer belongs and the available zone list appear.

ct the zone to which you want to switch the printer, and then click [Change].
nfirmation message appears.

k [Continue].
nfirmation message appears.

s [OK].

ct [Chooser] on the Apple menu.

k the [AdobePS] icon.

ct the zone selected in step BBBB on the [Appletalk zone:].

k to select the printer you want to use on the [Select a PostScript Printer:].

e [Chooser].
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ying the Printer Status

 display and confirm the current status of the printer.

ct [Display Printer Status...] on the [Utility] menu.

current status of the printer appears.

firm the current status of the printer.

 can confirm the memory capacity, the VM (Virtual Memory) space, the hard disk drive
available space on the hard disk drive. You can also confirm the zone to which the print
s to.

k [OK].

hing the Dialogue Console

 create and edit a PostScript file for printing, and download it to the printer.

ortant
nch Dialogue Console” is recommended for users with an understanding of PostScript.

ot download any file other than PostScript files to the printer.

nch Dialogue Console” must be used at your own responsibility.

ct [Launch Dialogue Console...] on the [Utility] menu.

 the editing screen. The Dialogue Console menu bar appears.
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e the PostScript command in the editor screen.

ote
o edit a PostScript file, select [Open] on the [File] menu to open it.

ou can search or replace a character string by using the [Search] menu.

r editing the PostScript file, select [Download Top Window] on the [Console] menu to
ting.

PostScript file is sent to the printer.

ote
he [Reply from Printer] box opens, depending on the PostScript file you sent.

ct [Return To Main Menu] on the [Console] menu to close the PostScript file.
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